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Choose this icon

preparation for survey 1 Make new project  1
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preparation for survey 2 Make new project  2

After clicked, You can see this window

If you want to make “New project”
Please move to P3

If you want to make “Open project”
Please move to P4
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preparation for survey 3 Make new project  3

Choose “New Project” After chose, You can see this window

Please make name
I recommend “place + Date”
For example, ”Lake Nyos 12242015”

After made name, Click “OK”
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preparation for survey 4 Open project  

First choose this iconWhen you want to open file , 

Choose “Open prject”
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Choose  this icon

preparation for survey 5 Geodetic parameter 1
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Please setting like this

preparation for survey 6 Geodetic parameter 2
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preparation for survey 7 How to add Background file 1

You can see “Background File” in “Project File”
Please right click on “Background file”,and choose TIF Files

Background File→Add file→TIF Files
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preparation for survey 8 How to add Background file 2

After add TIF file’s 
data, You can see 
plus mark on 
background Files

After click plus , 
You can see Tif file 
in Background Files
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preparation for survey 9 How to add Background file 3

Please click in box, then 
you can see Background 
image on HYPACK
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preparation for survey 10 How to make line 1

Click this icon And choose this icon

Editors→Line Editors
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preparation for survey 11 How to make line 2

After clicked “Line Editor”, 
You can see this window

Choose this icon
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preparation for survey 12 How to make line 4

After clicked “Cursor”, if you click on map , you can see blue point
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preparation for survey 13 How to make line 5

When you click again on map, You can see blue line 
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preparation for survey 14 How to increase line 1

Click this icon After clicked, You can see this window

Choose Parallel
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preparation for survey 15 How to increase line 2

If you choose “Lines left of 
center” and add 5 lines, 
you can see 6 lines.
1 line is old one,
5 lines are new one
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preparation for survey 16 How to increase line 3

If you choose “Lines right of 
center” and add 5 lines, 
you can see 6 lines.
1 line is old one,
5 lines are new one
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preparation for survey 17 Change distance between lines

Distance between lines 50 Distance between lines 100

When you decide “Distance between 
lines”, please input twice of depth
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preparation for survey 18 How to save 1

File→save as After made name to file, click “(S)”

After made file,  
You can see plus 
mark on Planned 
Line files
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When you add check mark in 
box, you can see line on map

preparation for survey 19
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preparation for survey 20 How to make Matrix file 1

Editors→Matrix Editor

Choose “Matrix Editor”
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preparation for survey 21 How to make Matrix file 2

After click “Matrix Editor”, 
you can see this window

Height Angle

WidthOrigin Point

We can move matrix by change 
value of “Corner X” and “Corner Y” 
or hold of matrix corner by mouse
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How to change heightpreparation for survey 22

Height
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How to change anglepreparation for survey 23

Angle
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How to change widthpreparation for survey 24

Width

25



How to movepreparation for survey 25

Origin Point
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When make Matrix, please make big more than line

preparation for survey 26
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preparation for survey 27

Please input Cell size about 1/10～1/20 of depth

Change Matrix type from HYPACK to HYSWEEP

Cell size 2m Cell size 0.1mCell size 30m
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File→save as After made name to file, click “(S)”

preparation for survey 28

After made file,  
You can see plus 
mark on Matrix 
Files
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When you add check mark in 
box, you can see line on map
Matrix is indicated by red line

preparation for survey 29
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Click this icon

Setting of HYPACK HARDWARE 1
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After click, You can see this window

Setting of HYPACK HARDWARE 2 Boat
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Can choose 
by left click

Setting of HYPACK HARDWARE3

Function: Choose all

Option: During getting data, can decide about color of depth value

HYSWEEP Interface

Connect: Choose None
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Offsets: Input about Offsets of  POS MV(Starboard/Forward/Vertical)

POS MV

Function: Input check mark to Position and Speed
Options: Input check mark to both

Connect: Choose Network Port
Network Parameter: Protocol→UDP

Role →Client
Host      →IP address of POS MV
Port       →5602

Write Port→0

Setting of HYPACK HARDWARE4

Can choose by left click

POS MV Offset 
Starboad 0m
Forward 0m
Vertical -      m
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About Offsets of POS MV, we need only Vertical 
value
Because base position is IMU

How to measure POS MV Offset

Starboard: 0m
Forward: 0m
Vertical: Have to measure

Setting of HYPACK HARDWARE5

IMU

This distance is Vertical
Water surface

When we measure vertical of POS MV off set, we measure from IMU 
surface to water surface. And then value is “ー”.
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Save as

Setting of HYPACK HARDWARE6
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Setting of HYSWEEP Hardware1

HYSWEEP→HYSWEEP Hardware
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R2Sonic SONIC 2024

Choose “Offsets”

Setting of HYSWEEP Hardware 2 
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R2Sonic SONIC 2024

Input about Offsets of R2Sonic SONIC 2024 (Starboard/Forward/Vertical)

Setting of HYSWEEP Hardware 3 

Sonar head 1 
Starboad -      m
Forward -      m
Vertical m
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Choose “Connect”

R2Sonic SONIC 2024Setting of HYSWEEP Hardware 4 
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R2Sonic SONIC 2024Setting of HYSWEEP Hardware 5 

Input to “Timeout Interval” 15.0 seconds. 
Of course you can change value

Please check about Port and Internet address

Please check 
“Enabled”
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R2Sonic SONIC 2024

Starboard: Have to measure 
Forward: Have to measure 
Vertical: Have to measure

Setting of HYSWEEP Hardware 6 

This distance is Vertical

IMU

Water surface

This distance is Starboard

IMU

Water surface

This distance is Foward
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Applanix POS/MV NetworkSetting of HYSWEEP Hardware 7 

Choose “Offsets”
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Applanix POS/MV NetworkSetting of HYSWEEP Hardware 8 

Input about Offsets of Applanix POS/MV Network (Starboard/Forward/Vertical)

MRU Offsets
Starboad 0m
Forward 0m
Vertical -      m
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Choose “Connect”

Applanix POS/MV NetworkSetting of HYSWEEP Hardware 9
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Input to “Timeout Interval” 15.0 seconds. 
Of course you can change value

Please check about Port and Internet address
Internet address is same with POS/MV’s IP address

Please check 
“Enabled”

Applanix POS/MV NetworkSetting of HYSWEEP Hardware 10 
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Applanix POS/MV Network

IMU

This distance is Vertical
Water sueface

Starboard: 0m
Forward: 0m
Vertical: Have to measure

Setting of HYSWEEP Hardware 11 
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Setting of HYPACK Navigation 1

Choose “Offsets”
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Input about Offsets of HYPACK Navigation (Starboard/Forward/Vertical)

Setting of HYPACK Navigation 2

Position Antenna Offsets
Starboad 0m
Forward 0m
Vertical  -      m
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IMU

This distance is Vertical
Water surface

Starboard: 0m
Forward: 0m
Vertical: Have to measure

About Offsets of GPS, we need only Vertical value
Because base position is IMU

Setting of HYPACK Navigation 3
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Setting of HYPACK Navigation 4

Choose “Connect”
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Input check mark to “Enabled”

Input to “Timeout Interval” 15.0 seconds. 
Of course you can change value

Setting of HYPACK Navigation 5
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Save as

Setting of HYPACK Navigation 6
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Setting of POS MV 1

Choose MV‐POSView 6.13

If equipments are connected, you can see green lump about Attitude/Heading/Position/Velocity
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Setting of POS MV 2

Choose MV‐POSView 6.13

If equipments are not yet connected, you can see red lump about Attitude/Heading/Position/Velocity
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Setting of POS MV 3

When change Offsets, choose  this Except change Offsets, choose this
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Setting of Offsets

After ckicked “STAND BY”,left click “Setting”

Click “STAND BY”

Setting of POS MV 4
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Choose “Installation”

Setting of OffsetsSetting of POS MV 5

Setting→Installation

58



Choose “Lever Arms & Mounting”

Setting of OffsetsSetting of POS MV 6

Setting→Installation→Lever Arms & Mounting
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When choose “Lever Arms & Mounting”, you can see this window

Input value to “Ref. to Primary GPS Lever Arm”
X is Forward, Y is Starboard, Z is Vertical
This value meaning is distance from IMU to Primary antenna

Setting of OffsetsSetting of POS MV 7

Distance from IMU to primary Antenna
X(Forward)  -      m

Y(Starboard) -      m
Z(Vertical)  -      m
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Primary antenna

View point from bow

IMU

Water surface
Z(Vertical)

X(Forward): Have to measure  
Y(Starboard): Have to measure

Z(Vertical): Have to measure

Setting of OffsetsSetting of POS MV 8

Primary antenna

X(Forward)

Y(Starboard)
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Choose Installation

Setting of OffsetsSetting of POS MV 9

Setting→Installation
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Choose “GAMS Params Setup”

Setting→Installation→GAMS Params Setup

Setting of OffsetsSetting of POS MV 10
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Input value to “Two Antenna Separation

Input value to “Baseline Vector”

X is Forward, Y is Starboard, Z is Vertical

When choose “GAMS Params Setup”, you can see this window

Setting of OffsetsSetting of POS MV 11
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Two antenna Separation: Have to measure
X(Forward): Have to measure  
Y(Starboard):0m

Z(Vertical): 0m

Setting of OffsetsSetting of POS MV 12

Primary antenna

Primary antenna

Secondary antenna

Secondary antenna

When we measure X(Forward), maesure from “primary” to “secondary”
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Save as

Setting of OffsetsSetting of POS MV 13

After “Save as”first click “NAV” And second click this

Setting→Save setting
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Check of Sonic 2022 1
Click this icon

If equipment is connected, you can see this window
(This screen is when Sonic 2022 is in water)

If “year and month and 
date” is true,this is 
ok,but if you see 
“1997”this is not ok

Normally value 
undergo a 
change(When 
R2Sonic power on)
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If equipment is not yet connected, you can see this window
(This screen is when Sonic 2022 is in air)

Check of Sonic 2022 2
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If you do right click, value increase
When you do left click , value decrease 

Red dots are bottom of lake

Check of Sonic 2022 3
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If depth is under 100m, please 
input 400
If depth is over 100m, Please 
input 200

Choose “Equidistant”

Choose “Down, Bathy, Normal”

Choose “Single head”

Choose “Aft”

Choose “120”

Check to “Sonar Power On”

Click “Close”

Check of Sonic 2022 4
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Depth Frequency
setting

Power 
setting

Gain 
setting

Pulse Width 
setting

Under 20m 400 kHz 191 3 20
20～50 m 400 kHz 194 3 25
50～70 m 400kHz 203 3 60

100～200 m 200 kHz 215 15 200
200～300 m 200 kHz 221 23 500
Over 300m 200 kHz 221 30 700

For example

Check of Sonic 2022 5
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Choose “Gate Trac: Depth + Slope

Please choose ±40 %
this can change left and right click

Please put check to both

Check of Sonic 2022 6
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How to control during surveying 1 

Choose “Survey”
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Choose “HYPACK Survey and HYSWEEP Survey”

How to control during surveying 2 

Survey→HYPACK Survey and HYSWEEP Survey
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When you choose “HYPACK Survey and HYSWEEP Survey”, You can see this window

Survey window is like menu of during survey

How to control during surveying 3 
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Typical window 1

Survey→Window→New→Data Display

You can check various data of during survey

How to control during surveying 4 
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Survey→Window→New→Map Window Ypu can check where is our boat on map

Typical window 2How to control during surveying 5 
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Survey→Window→New→Left/Right Indicator

You can check about how to far from line to boat
Red territory is direction to left side
Green territory is direction to right side

Typical window 3How to control during surveying 6 

Your boat Distance from selected “Planning line”
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HYSWEEP Survey

Menu of “HYSWEEP Survey”

If you can see all equipments
are green except “Sidescan”,this 
is OK.
But if you see some equipments
are red lump, this is problem.
So you have to check 
connection.

How to control during surveying 7 
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HYSWEEP Survey

HYSWEEP Survey Window→View→3D Seafloor

How to control during surveying 8 

HYSWEEP Survey Window→View→3D Seafloor
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About recording of data

●Start and end of recording
Start：Ctrl + S
End：Ctrl + E

You can check already start or not yet start by “Status
“ indication ”NOT LOGGING” or ”LOGGING”
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●Indication of screen(Zoom and Zoom out)

“Shift key” and “+”

“ ー ”
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●Indication of screen(Left and right scrolls)

“→”key

“←”key
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“↑”key

“↓”key

●Indication of screen(Up and down scrolls)
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●Indication of screen(Increase and decrease of selected line)

“Ctrl”key + “ Ｉ ”

“Ctrl”key + “D”
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●Indication of screen(change direction)

“Ctrl”key + “W”

“Ctrl”key + “W”
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Abut Patch test(Roll)

Same line
Flat bottom
Same speed with survey

①

②
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About Patch test(Pitch)

⑤

⑥

Same line
Sloop bottom
Same speed with survey
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About Patch test(Yaw)

⑦

⑧

Two lines, Same direction
Sloop bottom
Same speed with survey
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1.Please try to get data at deepest area.
2.Rope connect with shackle of “Minos”.
3.Remove dummy plug(Black color), and connect shorting plug(Red color).
(Automatically POWER ON)

4.Please check LED indicator is Green lump(Solid) or not.
5.Continue  to enter sensor part to water surface.
6.Please wait until LED indicator’s Green lump(Solid) change to Green lump(Flash). 
7.Casting to water, and about speed please keep  about 1m/s.
8.When you could check about arrived bottom , You can raise “Minos”.
9.Please remove water around shorting plug(Red color) .
10.Change to dummy plug(Black color).

Shorting plug

Shackle

Dummy plug

Mino
s

About Minos 1
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About Minos 2

About “Minos” battery
LED Indicator pattern meaning
Green color(Solid): POWER ON and battery has power more than 20%
Green color(Flash):Recording data and battery has power more than 20%
Red color(Solid):POWER ON and battery has power less than 20%
Red color(Flash):Recording data and battery and battery has power less than 20%
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Connect to PC

Minos SVP

Power

When you need charge, please use this

We don’t use

Connect to Pc

About Minos 3
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Sensor connect

When you choose “comport”, automatically connect

Click this icon  On desktop

About Minos 4
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You can choose method from 
“Time” or “Depth” or “Speed”

SetupAbout Minos 5
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Input file name, and after named click “Apply”
When you want to clear memory in Minos, choose and click “Apply”

Setup 2About Minos 6
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Choose “Log file” and “Cast”
Can change to depth
Click “Save Cast”

About Minos 7
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Data post processing (Sound velocity data 1)

Choose “Processing”

97



Choose “Sound velocity”

Data post processing (Sound velocity data 2)

Processing→Sound Velocity
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Data post processing (Sound velocity data 3)
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Import text file of sound velocity

Data post processing (Sound velocity data 4)

File →Import
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We needs Sound velocity and depth value

Data post processing (Sound velocity data 5)
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Data post processing (Sound velocity data 6)

We input mark to sound velocity and depth value, (no need another information)
And “Accept Record”
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These value are not normal, so choose and click “Delete Row”
We need every 1m,so please sort by yourself.(This depend on data amount of depth)

Data post processing (Sound velocity data 7)
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After remove abnormal value, You can see graph

Data post processing (Sound velocity data 8)
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Save as

Data post processing (Sound velocity data 9)
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Data post processing （MB MAX1）

Choose this
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When you do post processing from beginning, you choose “Raw”
When you do post processing from middle, you choose “Edit” 

Data post processing （MB MAX2）

You can see this windowAfter chose this
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Choose file and click “Select”

Data post processing （MB MAX3）
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Choose “Depth” and click “OK”

Data post processing （MB MAX4）
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Choose “Sound Velocity file” and click “OK”

Data post processing （MB MAX5）
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Please check about Sonar is “R2Sonic SONIC 2024” 

Please check about Navigation is “Hypack Navigation” 

Please check about Heave/Ptich/Roll/Heading is “Applanix POS/MV Network”  
Please check about Tide is “None” 

Data post processing （MB MAX6）
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Choose “R2Sonic SONIC 2024”,and please check Offsets is “Sonar Head 1” or not

Please check about value of Starboard/Forward/Vertical are same with Offsets or not

Data post processing （MB MAX7）
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Choose “Hypack Navigation”, and Please check about Offsets is “Position Antenna Offsets” or not

Please check about value of Starboard/Forward/Vertical are same with Offsets or not

Data post processing （MB MAX 8）
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Choose “Applanix POS MV Network”, and Please check about Offsets is “MRU Offsets” or not

Please check about value of Starboard/Forward/Vertical are same with Offsets or not

Data post processing （MB MAX 9）
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Input check mark to “Correct for Induced Heave”

Data post processing （MB MAX 10）

Click “OK”
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After click “OK”, You can see these windows

Data post processing （MB MAX 11）
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Heave Window Pitch, Roll and Heading

File name

Phase1 Menu
Data post processing （MB MAX 12）
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Survey Window Tide and Draft Corrections

Sound Velocity Profile

Data post processing （MB MAX 13）
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After checked Phase1, move to Phase2

Move to Phase2

After moved to Phase2,You can see these windows

Phase2 Menu

Data post processing （MB MAX 14）
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Sounding Info Sweep Window

Data post processing （MB MAX 15）
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Remove noise

Data post processing （MB MAX 16）
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Choose floppy disk, and 
choose “all data” and 
click “OK”

Data post processing （MB MAX 17）
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Restart MB MAX

Open log file of for Patch test

After removed noise data is saved in “Edit File”

Data post processing （MB MAX 18） Roll Patch test
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Click “OK”

Data post processing （MB MAX 19）

Choose file and click “Select”

Roll Patch test
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Please don’t put file
Just click “OK”

Click “OK”

Data post processing （MB MAX 20） Roll Patch test
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Move to Phase2

Move to Phase3

Input 1/10 of depth value by meter
Check to “Enter 
Cell Length and 
Width”

Click “OK”

Data post processing （MB MAX 21）

Check to “Auto 
Size Data”

Roll Patch test
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After click “OK”, You can see this window

Roll Patch testData post processing （MB MAX 22）

Then click &drag the cursor to 
draw a line as shown in picture 
(left)

Choose this icon
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You can see Patch test window

Cross section

Graph of result

Choose “Roll”
1, Click “Coarse Steps”
2, Click “Start Roll Test”
3, Click “Medium Steps”
4, Click “Start Roll Test”
5, Click “Fine Steps”
6 , Click “Start Roll Test”
7, Please memo Final Offsets value
8, After wrote value, Click “Close”

Data post processing （MB MAX 23） Roll Patch test
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Please check about 
overlapping  lines or not,
Graph form is OK or not

Data post processing （MB MAX 24） Roll Patch test
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Pitch Patch testData post processing （MB MAX 25）

Restart MB MAX

Open log file of for Patch test

After removed noise data is saved in “Edit File”
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Data post processing （MB MAX 26）

Click “OK”

Choose file and click “Select”

Pitch Patch test
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Data post processing （MB MAX 27）

Please don’t put file
Just click “OK”

Click “OK”

Pitch Patch test
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Data post processing （MB MAX 28）

Move to Phase2

Check to “Enter 
Cell Length and 
Width”

Click “OK”

Check to “Auto 
Size Data”

Input 1/10 of depth value by meter

Pitch Patch test
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Data post processing （MB MAX 29）

After click “OK”, You can see this window
Then you can draw like red line

Choose this icon

Pitch Patch test
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Data post processing （MB MAX 30）

Cross section

Graph of result

Choose “Pitch”
1, Click “Coarse Steps”
2, Click “Start Pitch Test”
3, Click “Medium Steps”
4, Click “Start Pitch Test”
5, Click “Fine Steps”
6 , Click “Start Pitch Test”
7, Please memo Final Offsets value
8, After wrote value, Click “Close”

Pitch Patch test
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Yaw Patch testData post processing （MB MAX 31）

Restart MB MAX

Open log file of for Patch test

After removed noise data is saved in “Edit File”
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Data post processing （MB MAX 32）

Click “OK”

Choose file and click “Select”

Yaw Patch test
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Data post processing （MB MAX 33）

Please don’t put file
Just click “OK”

Click “OK”

Yaw Patch test
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Data post processing （MB MAX 34）

Move to Phase2

Check to “Enter 
Cell Length and 
Width”

Click “OK”

Check to “Auto 
Size Data”

Input 1/10 of depth value by meter

Yaw Patch test
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Data post processing （MB MAX 35）

After click “OK”, You can see this window
Then you can draw like red line

Choose this icon

Yaw Patch test
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Data post processing （MB MAX 36）

Cross section

Graph of result

Choose “Yaw”
1, Click “Coarse Steps”
2, Click “Start Yaw Test”
3, Click “Medium Steps”
4, Click “Start Yaw Test”
5, Click “Fine Steps”
6 , Click “Start Yaw Test”
7, Please memo Final Offsets value
8, After wrote value, Click “Close”

Yaw Patch test
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Open hsx_※※※（←this is date）. log

Data post processing （MB MAX 37）

Restart MB MAX
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Choose all Files

Data post processing （MB MAX 38）
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Click “OK”

Data post processing （MB MAX 39）
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Data post processing （MB MAX 40）

Please don’t put file
Just click “OK”
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Click “Device Info”

Data post processing （MB MAX 41）
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Input Patch test value

Click “OK”

Data post processing （MB MAX 42）

Choose “R2Sonic SONIC 2024” ,and please check Offsets is “Sonar Head 1” or not
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Choose “Auto Size to Data”

Choose “Enter Cell Length and Width” and input depth value of 1/10 by meter

Click “OK”

Choose this

Make grid file（MB MAX 43）
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Choose “XYZ Points Only – ASCⅡ XYZ Format”

Choose “No Reduction”(Save to Edit folder)

Choose “Save One Point per Cell”(Save to Sort folder)

Before click “OK”,Please check “XYZ Reduction”

Make grid file（MB MAX 44）
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Choose “Use Cell Center XY”

Make grid file（MB MAX 45）

This window is when you choose “One Point Per Cell”

Popular selection is Mode/Minimum/Mux
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Bathymetric map 1

Choose “XYZ’s file”
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These data are too much data
We can’t see number without scale up
So we need thinning up

Bathymetric map 2

Zoom
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Choose “Sort”

Bathymetric map 3

153



Choose file,and right click and click “Enabled”

Decide of Sort’s radius

Please make name for after sort’s file

Click “Sort”

Bathymetric map 4
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How to make Matrix data 1 

Choose file for make Matrix data by HS2 or XYZ file , and move to Phase3

Click 

Make name

Click (S)
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After clicked “Sort”, You can see sort file in Data Files

Bathymetric map 5
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You can see Matrix file in Project Files

How to make Matrix data 2 
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How to make TIN Model 1

When you didn’t choose file, You can not click these

Make new TIN Model

Open TIN Model file
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Input grid file

Please input about 5 times of grid size

Click “OK”

How to make TIN Model 2
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How to make TIN Model 3
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Export→DXF

How to make TIN Model 4 ( Depth counter diagram) 

Click “DXF”
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Choose “2D Counter”

Interval of depth counter

Click “Counter Attributes”

How to make TIN Model 5 ( Depth counter diagram) 
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After setting Click “OK”

How to make TIN Model 6 ( Depth counter diagram) 
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After click “OK”, You can see DXF file in Project Files

How to make TIN Model 7 ( Depth counter diagram) 
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Google map1

First, Please search photo on Google map
And do “Prt Sc”, and save by use “TIF file”
From next slide,we choose 3 points
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Google map2 Point 1

Please decide first mark on map

Scale up
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Google map3 Point 1

Right click on mark

And then You can see “What’s here?”
So please click this
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Google map4 Point 1

You can see longitude and latitude on Google map
So please memo these information
This time is “35.311937 , 139.739408”

168



Google map5 Point 2

Scale up
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Google map6 Point 2

Right click on mark

And then You can see “What’s here?”
So please click this
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Google map7 Point 2

You can see longitude and latitude on Google map
So please memo these information
This time is “35.300370 , 139.661259”
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Google map8 Point 3

Scale up
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Google map9 Point 3

Right click on mark

And then You can see “What’s here?”
So please click this
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Google map10 Point 3

You can see longitude and latitude on Google map
So please memo these information
This time is “35.331370 , 139.818715”
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Google map11
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Google map12

Preparation→Editors→Image Geo Reference
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Google map13

Image→Load

Choose “TIf file”

Click “(O)”
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Google map14

You can see TIF image in software

178



Google map15 Point 1

Scale up Point 1
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Google map16 Point 1

And double click on markChoose this
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Google map17 Point 1

Input longitude and latitude to World X, World Y

World X:35.311937N
World Y:139.739408E

Click “OK”

Please choose “ WGS84 LAT/Lon
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Google map18 Point 1

You can see this red point after double click
If you missed point, you can recover by right click
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Google map19  Point 2

Scale up Point 2
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Google map20 Point 2

World X:35.300370N
World Y:139.661259E

Input longitude and latitude to World X, World Y

Click “OK”

Please choose “ WGS84 LAT/Lon
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Google map21 Point 2

You can see this red point after double click

If you missed point, you can recover by right click
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Google map22 Point 3

Scale up Point 3
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Google map23 Point 3

World X:35.331370N
World Y:139.818715E

Input longitude and latitude to World X, World Y

Click “OK”

Please choose “ WGS84 LAT/Lon
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Google map24 Point 3

You can see this red point after double click
If you missed point, you can recover by right click 188



Google map25

Please check about can see 3 points

After check click “3 +PT Rectification” 189



Google map26

Chose “Save”

Click “OK”
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Google map27

Click (S)

Make name
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Google map28

You can see tif file in Project Files
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